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Executive Summary 

The Viticulture Society of the Canberra District (VSCD) was successful in 2023 in obtaining a 
Progression Grant through AgriFutures Australia as an extension to a Producer Technology 
Uptake Project (PTUP). This funding supported a project to trial ‘Digital Viticulture in the 
Canberra District’. This is the final report of that project. 

As part of the PTUP ‘Digital Viticulture’ project, the VSCD hosted three workshops delivered to 
grower groups as well as a final project seminar hosted in October 2024 that provided an 
overview of the outcomes and products developed under the project. In addition, the VSCD 
hosted a AgTech Innovation in Viticulture event in Murrumbateman which was attended by 35 
industry representatives. 

The Progression Grant involved eight growers within the Canberra District who tested a range of 
technologies being trialled on their vineyard sites under this project over the 2023 and 2024 
vintages.  

The VSCD has developed a 'Digital Viticulture' user guide instruction manual for drone 
operations (Attachment A) to enable users to develop their own ‘digital assets’ through drone 
mapped blocks and rendering these into geographic information system (GIS) software formats 
– such as QGIS -  which can then be manipulated and layered for analysis of a range of factors 
and data.  

Specific communications / videos and guides have also been developed and are hosted on the 
VSCD webpage (www.canberragrapes.net.au). These links have been emailed to VSCD 
members and can be made available to other industry stakeholders on request. 

A future additional communication, is a series of short articles on learnings from the group trial 
and members adoption of digital viticulture technologies, based on the series of case studies 
that were presented in the final project seminar and outlined in this Final Report. The intention 
is to publish the articles in the Australian / New Zealand Grape Grower and Wine Maker 
Magazine post-project. The first of these is scheduled for the December 2024 edition. 

This report provides insights into the trade offs for small grower groups of capital investment 
and advanced digital literacy – the capability to share information internally and the need to 
invest in expertise. The provision of base line standards for open comparative data is a necessity 
for growers in their ability to deliver consistency and quality using advanced technologies, such 
as drone maps, AI recognition, and data capture and reporting. 

 

Introduction 

The Viticulture Society of the Canberra District (VSCD) 'Digital Viticulture' Progression project 
was facilitated by Hans Loder of Vitifelix Pty Ltd, a Senior Viticulturalist and digital viticulture 
expert. Hans was involved in the Wine Australia ‘Collabriculture’ project that created standards 
for drone mapping data, and the digital literacy, data protocols and nomenclature associated 
with establishing standards to progress its uptake. This Progression project build upon the initial 
VSCD PTUP project which trialled drone vineyard flights and rendered these into GIS maps 
which occurred across vintages 2022-2023. 
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This report outlines the content from workshops delivered throughout the project for our grower 
group participants, aligned with critical phenological stages in the vineyard. A number of case 
studies based on the workshops and developments throughout the growing season are 
presented here (see Workshop overview diagram below).  

Workshops overview 

 

This project kicked-off with an on-line workshop which provided a broad overview of image/data 
capture and how this aligns with the growing season that was held on 31 August 2023. This 
included presentations by Airborne Logic and Mammoth Geospatial on the use of drone 
mapping software platforms. 

A second 'Budburst' workshop, hosted at Pankhurst Winery in Wallaroo, NSW was held on 29 
September. Around 20 people attended representing around 10 vineyards. This demonstrated: 

• An overview of the opportunity provided by Precision Viticulture and mapping of 
vineyards 

• BitWise bud and bunch count software data collection using a GoPro mounted to an ATV 
and then the processing of data and results; and   

• A Mavic 3 drone to block map, with images stitched through Terra software and then 
layered into the QGIS open platform software.  

Shortly after this workshop a significant frost event occurred across the Canberra District in 
November 2023. The group held a follow-up discussion around the impact of frost on vineyards 
and the option to drone map the frost footprint, the use of weather and temperature sensors, 
frost fans and other technologies that could be positioned and deployed automatically to 
reduce the risk of damage from future frost events. It was agreed a future project would explore 
in detail the linkages between drone mapping and use of AgTech devices as a focus of the group 
trial.  

A second in-person 'Flowering' workshop was held at Norton Road Wines, Wamboin, NSW, on 1 
December 2023. Around 15 people attended representing around 10 vineyards.   This workshop 
included: 

• Presentations on uploading drone maps to QGIS and MyEfficient Vineyard open source 
website apps  

• the use of an RTK Rover to provide GPS position data on blocks  
• the demonstration of a handheld Greenseeker unit capturing NDVI data, and  
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• using the MyEfficient Vineyard and QGIS apps to present data. 

A third in-person 'veraison' workshop was held on 1 March 2024 at Quarry Hill vineyard, Jeir, 
NSW.  Around 10 people attended representing around 5 vineyards - with numbers significantly 
impacted by the early vintage for season 2024. This demonstrated:  

• FarmingIT’s use of a mobile ATV mounted Greenseeker NDVI 
• GPS data transfer in real-time via Mammoth Geospatial in Perth which uploaded the 

data and presented this into QGIS mapping software, and  
• discussion of the importance of quality data collection given the limitations to post – 

processing of bad data. 

The QGIS demonstration demonstrated how individual vines can be mapped and NDVI data 
snapped to these in QGIS using GPS positions. The analysis of vegetation index as an indicator 
of dieback and/or vine status data and block contours was also demonstrated. Significantly, this 
showed how vendors offering software services, such as Mammoth Geospatial, are available to 
render drone maps on a fee for service basis and that this option can make significant 
efficiencies through reducing the need for growers to master complex software such as QGIS.   

This highlights a key finding from this project – how do the costs and benefits of engaging 
vendors to undertake tasks compare to using a shared collective resource and do it yourself 
approach.  The time and capital resources required to establish, maintain and master the digital 
viticulture assets for each of the technology options explored as part of the project are key 
considerations in this assessment. Overall, these will depend on the use case, scale of vineyard 
operations and interests/skill and digital literacy (often advanced) of the vineyard manager to 
master skills as diverse as piloting a drone, surveying principles and digitising maps using GIS 
software. This is discussed within each of the case studies as part of the technology evaluation 
below. 

A number of trouble shooting workshops were held post-vintage – and will continue – which 
allow participants in our grower group trial to work through processing of the data taken from 
drone mapping, BitWise GoPro imaging, NDVI Greenseeker data and rendering this into QGIS / 
MyEfficient Vineyard maps and data management resources and analysis.  

As outlined above, a number of AgTech consultants were engaged during the course of this 
project in both the provision of technologies and demonstration of how they can be used. 
Software and hardware vendors as part of the trial included: 

• Airborne Logic - drone mapping software - Dan French 
• Mammoth Geospatial – open source QGIS and farm mapping - John Bryant 
• Farming IT - Greenseeker NDVI side imaging of vines - Martin Peters 
• Bitwise Agronomy - bud and bunch counting - Fiona Turner 
• MyEfficient Vineyard – open source vineyard mapping and web portal, and 
• Drone sales and training services (DJI, Tocal College and NSW Skills).  

These vendors informed the series of case studies of 'digital viticulture tools' that were 
discussed at a final project seminar held at Mt Majura Vineyard, Canberra, in October 2024. The 
final project seminar encouraged VSCD members to become involved in the use of these 
technologies and resources for vintage 2025.  

The online Viticulture Vignettes showcase the following use-cases: 
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• Block maps of existing vineyards as a basis to establishing a ‘digital twin’1 of the vineyard 
• New block feasibility mapping 
• Frost events and options for measuring damage, quantifying yied loss and optimising 

positioning of frost fans for maximum effect 
• Bunch count yield estimates, finding an easier way to collecting representative data; 

and 
• Canopy health and quantifying vineyard dieback through causes such as Eutypa lata 

and monitoring grafting uptake and vine repair. 

 
In addition, a final AgTech Innovation demonstration event was held by the VSCD which was 
funded through the Australian Government’s Department of Agriculture, Fisheries and Forestry 
(DAFF) at the end of October 2024. This informed the final case study on AgTech options for 
vineyard monitoring and management. An Expert Panel session discussed detailed vineyard 
mapping and the value propositions and practical approaches to Precision Viticulture as well as 
AgTech adoption, to help identify the essential, nice to have and emerging AgTech innovations 
for viticulture. 
 
The event was promoted nationally and communicated to neighbouring grower groups, such as 
Tumbarumba, Orange, and Southern Highlands, to raise their awareness of adopting drone 
mapping and AgTech to create their own ‘digital assets’2. Though we experienced limited 
interest from these neighbouring regions, this report and materials from this project will be 
made widely available, including through the AgriFutures website and we shall encourage them 
to visit these sites and follow our technology adoption journey.  
 
As noted by Wine Australia, extension and adoption of innovation is changing. 
 

“Contemporary extension has shifted from focusing largely on the technical content 
alone to include greater understanding of people, decision-making processes, impact of 
change, and the ways that different people learn. Adoption is recognised as a ‘process’ 
of learning and change rather than a ‘point in time event’ or one-off binary decision. This 
is particularly important for complex farming systems where change is dependent on 
production cycles and impact is realised over a longer term.”3 

 
This PTUP project is an example of a small regional grower groups commitment to working with 
new technologies and establishing a practical approach to its adoption. This is an ongoing 
journey – that will only become more critical with the demands of scarce resources, consumer 
preferences and tracability, and the impact of climate change, demanding sustainable practices 
going forward – which in itself will be a point of difference and value. 
 
 
 
Before you get started 

 
1 What is a ‘digital twin’?  A digital twin generally incorporates the use of real time data and/or involves 
simulation modelling. As such, a digital map itself doesn’t represent a digital twin, it’s simply a digital 
representation of the real world, but add data from IoT devices and make it interactive… Bingo!  
Given this, the project creates ‘digital assets’ that can form the basis for establishing a ‘digital twin’.  
2 “AgTech Innovation in viticulture: Demonstration event – Murrumbateman 25 October” Grape Grower 
and Winemaker Magazine, Issue 729, October 
3 https://www.wineaustralia.com/news/articles/evolving-how-research-information-and-innovation-
delivers-greater-impact-and-value-to-the-sector 
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The initial premise for the project was to explore the cost and benefits of drone mapping for 
small scale viticulturalists. The initial PTUP workshops for this project provided an introduction 
into developments in AgTech and drone technologies, which in relatively recent times has 
become a more cost-effective and widespread technology. The resolution and collection of 
NDVI vegetative indices by cameras on drones – as compared to satellite -  and the ability to 
process imaging is a new innovation over the last decade that is now accessible to small scale 
growers. The resolution from satellite is around 1m whereas drone imaging linked into the 
Geoscience Australia system is around 2cm. This technology provides the opportunity to 
monitor the health and growth of individual vines – a game changer for productivity.  
 
Given recent wine commodity trends, the future ‘digital twin’ for a vineyard is valuable for 
farmers as a ‘digital asset’ that aids in the understanding of their property and its nuances, 
finessing current production or alternative land use and crops coming into play – often through 
necessity. The digital asset created through drone maps enables farmers to assess different 
options – an important management tool for value creation – especially with the prospect of 
climate disruption, commodity price fluctuation and new market opportunities. 
 
Access to the use of these new technologies is increasing as the costs decrease. The 
technology services, equipment and software available is sometimes nebulous but also gaining 
critical demand to enter into the mainstream.  Much of the viticulture sector follows gains in 
broad acre and general technology – such as drone use.   
 
This trial project group had a fantastic opportunity through our grant monies to examine what 
and how was needed to create digital drone maps, whether this was feasible both on a 
collective basis and on an individual grower basis. As outlined above the project was informed 
by the earlier Collabraculture project funded through Wine Australia.4 Unlike this initiative, our 
project was a trial of small scale growers looking to test and leverage these findings through 
dedicated funding from AgriFutures to assess technology options and scalability. 
 
From the outset, the project established what was required to undertake drone mapping and 
side – on imaging and the indicative budget required for these technologies. The first issue was 
drone licensing. Although now optional – training in drone licensing was beneficial to better 
understanding what is involved in flying a drone and the legal aspects. Training provides users 
with the license to fly drones on their own properties – but not on third party properties (this is a 
commercial drone licence).  
 
The capital costs to commence drone mapping includes: 
 

• Drone technology with RBG / NDVI camera for true colour to develop surface models 
and contours, along with vegetative mapping (plus tablet for screen, software 
subscriptions, additional batteries and Micro SD card) – estimated $8 to $10k 

• A PC with quality graphics card (GPU) to process digital maps – estimated at $3k to $5k 
  

 
4 See https://winetitles.com.au/accurate-maps-will-show-the-path-to-technologys-treasures/ and 
https://winetitles.com.au/what-are-the-most-important-features-of-your-vineyard-to-map/ and 
https://www.wineaustralia.com/research_and_innovation/projects/collabriculture-an-open-and-
collaborative-approach-to-technology-in-the-wine-industry 
 
 
 

https://winetitles.com.au/accurate-maps-will-show-the-path-to-technologys-treasures/
https://winetitles.com.au/what-are-the-most-important-features-of-your-vineyard-to-map/
https://www.wineaustralia.com/research_and_innovation/projects/collabriculture-an-open-and-collaborative-approach-to-technology-in-the-wine-industry
https://www.wineaustralia.com/research_and_innovation/projects/collabriculture-an-open-and-collaborative-approach-to-technology-in-the-wine-industry


‘Digital viticulture in the Canberra District’ 
 

7 
 

As part of the Group Trial the VSCD purchased a DJI Phantom 4 with Multispectral Camera for 
NDVI images, a tablet for drone interaction, lap-top with graphics card and software (DJI Terra) 
to process imaging. We then engaged a viticulturist with experience in the application of digital 
viticulture / drone technologies as a project consultant / mentor to advise on the plan and 
timeline for the group technology trial. 

The NDVI camera and drone, and related laptop with graphics card required to process imaging 
is cost prohibitive to most individual small vineyard growers, at around $15k. The ability to share 
this resource and learnings (and manual developed in-house) as to how to operate the drone 
was through a buddy system between growers licensed to fly drones.  The drone flights over 
optimum time during vintage to record imaging and the ability to process images and interpret 
them is Case Study 1 below. 

As the project progressed the workshops were increasingly around engagement with vendors to 
gain an understanding of how to process digital vineyard maps through opensource software 
such as QGIS and MyEfficient Vineyard. This also demonstrated that many of the processes 
involved in mapping could be outsourced to these vendors if necessary – and the efficiencies 
that could be had through doing so, given the complexity of understanding software programs 
etc. 
 
Airborne Logic: Detailed vineyard analysis using precise digital maps 
 
Airborne Logic services include vineyard mapping and analysis, or alternately, processing drone 
map imaging from growers, and analysis such as plant counts, gap analysis and canopy density 
and vine health assessment. Flowering and veraison are key imaging times to create consistent 
data each season which allows for layering of imaging. This provides opportunities to identify 
problems within a season or on a temporal basis that can be targeted through GIS location.5 
 
 
In contrast, there are some technologies that the trial found are easily accessible and deliver a 
near equivalent result to more expensive vendor options. There can be cost savings from a ‘do it 
yourself’ and collaborative approach, if you have access to some advanced digital literacy in 
your grower group! The report below outlines where this can occur. Case studies 2, 3 and 4 
point to the alternative options.  
 
There are also risks associated with trialling new hardware, its ongoing software support, and 
using vendors and their platforms – who themselves are subject to competition, acquisition, 
and business continuity, given the pace of technology evolution in digital agtech. However, to 
mitigate these risks there are also some ways to ensure that there are levels of continuity in 
maps that are generated through the use of compatible software formats and standards – 
preferably open source. Open source platforms which are technology agnostic, such as QGIS, 
allow for plug in and upgrades that may be more cost effective than a specific software vendor 
solution – but this depends on the capacity to pay and adopt. 
 
The Collabriculture project was focussed on establishing open source protocols and standards 
for the viticulture sector and they provide a foundation for organising data into hierarchies and 
their storage in relation to digital mapping. This is outlined in Case Study 4. 
 

 
5 https://www.youtube.com/watch?v=uMe0c7gS9Us 
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Finally, the insights from digital mapping points to the need for AgTech solutions to either assist 
with the monitoring and management of vineyard issues and opportunities to create efficiencies 
and increase productivity are ever evolving. Case study 5 takes a snap shot of AgTech relevant 
to viticulture, particularly as strategic Agtech adoption as an outcome of vineyard mapping.  
This is informed by an Expert Panel session hosted by the VSCD on 25 October 2024 that 
discussed detailed vineyard mapping and value propositions from the application of AgTech 
products. The session provided insights into strategic AgTech adoption to help identify the 
essential, nice to have and emerging AgTech innovation for viticulture. 
 
The conclusion to this report summarises key findings and a future work program for technology 
uptake and insights. 
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Case study 1: Drone Mapping vineyard block boundary and optimal 
flight times for vegetative mapping during the season 

The Group Trial on a select number of demonstration vineyards – Norton Road Wines, Pankhurst 
Wines, Mount Nanima, Ridley Station, and Quarry Hill Winery. The key deliverables were: 
• Undertaking an aerial survey using a DJI Phantom 4 drone with a RGB camera to map block 

boundaries,  
• Rendering images through DJI Terra Software into file formats for importing into QGIS and 

processed options into the MyEfficientVineyard application 
• Undertaking further aerial surveys at flowering and veraison using multispectral camera to 

produce an NDVI or PCD images, and 
• Importing data in QGIS to present imagery in industry accepted colour ramps and identify 

any sub - block zones. 

Outcomes in terms of key learnings for grower members were: 

• "Top down" imagery,  
• The importance of block boundaries and consistency in their mapping,  
• Commonly used file formats, 
• Appropriate timing of surveys, 
• Data processing, and 
• How to assess imagery and present/manage data. 

Optimal timing of drone flights are as follows. 

(1) Winter Dormancy - Aerial Survey to Collect Block Boundaries (August-October): 

• Dormancy provides an opportunity for a clear top–down view of the vineyard structure, 
including strainers, rows, posts and vines.  

• Processing of imagery required using specialised software DJI Terra and QGIS.  
• Application of RTK point referencing for ground control points (GCPs), specific vineyard 

infrastructure, such as block boundaries, end posts, irrigation and power infrastructure. 

(2) Early Season ‘Flowering’ (October/November) 

• Aerial Survey to Collect Multispectral Imagery and Survey for grapevine performance and 
identification of diseases such Eutypa lata dieback, before gaps become obscured by 
adjacent canes/growth, either RGB or NDVI can be used to detect this. 

(3) Veraison (January/February) 

• Aerial Survey to Collect Multispectral Imagery to identify variability and determine sub–
block zones. 

• This survey is based around the assumption that canopies have reached their maximum 
size by this time. If mid – rows remain green, and canopies are trained into tight vertical 
shoot positioning “VSP” structure, it can be of benefit to have imagery processed to vine 
only to accurately identify trends. 

(4) Harvest (March/April) 

• Delineation of zones and evaluation of variables i.e. yields versus imaging - to what sub–
block zones could mean for maturity sampling and harvest planning.  
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• Workshop 1 demonstrated the new Mavic 3 drone to block map, with images stitched 
through Terra software and then layered into QGIS. 

 
The VSCD instruction manual outlines the process to undertake drone boundary maps, use of 
Terra software and uploading maps into QGIS.  This includes learnings such as optimum flight 
path and time for image generation; optimum overlap settings;  flight path across or along row 
orientation, and elevation tracking. 
 
The next section outlines instruction for growers on how to render block maps with additional 
layers, such as end posts, rows, and contour maps. 
Image of DJI drone software flight path on Tablet

 

 

See the upcoming VSCD Vineyard vignettes 

• Block maps of existing vineyards as a basis to establishing a ‘digital asset’ 

• New block feasibility mapping 

Go to Canberragrapes.net.au 
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Case study 2: Processing map imaging through open-source software 
and creating block features and areas of interest  

Processing Imagery through open source software can reduce the costs of software 
subscriptions in order to use drone maps. Use of best – practice protocols of data collection 
and then processing can also ensure that outputs are of survey grade quality 

For example, QGIS software allows for the editing and manipulation of captured imagery to 
highlight specific items of interest.  

QGIS can be used to remove the vine “interrow” from images to provide representative maps of 
(vine only) vigour for Normalised Difference Vegetation Index (NDVI) and Plant Cell Density 
(PCD).  

Having produced a base map from the aerial image using QGIS, it opens the opportunity for its 
export and upload into a myriad of other spatial software and/or app’s, to delineate a vineyard 
for any future subscription or purpose. More detailed observations can also be overlaid on this 
map, with tracking of items such as dieback, virus, infrastructure etc. to the row or vine level 
possible. 

QGIS also allows for rows to be drawn and buffers determined (say 1.5 m) for rows or polygons 
to be generated. Overlays of polygons can be used to show areas of vine dieback, for example, 
on maps. Productive metres per row can then be displayed / determined, quantified and 
reported with GIS location precision.  

Image of DJI Terra software NDVI map  
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An RTK Rover can also be used to provide GPS position data on blocks, such as pump and other 
block infrastructure locations. 

The VSCD Instruction Manual and Vineyard Vignettes shows how to upload drone maps to 
QGIS. QGIS block features mapping can include post ends, rows, canopy buffering, broken 
posts, utilities, frost damage, water pooling and drainage etc. 

MyEfficent Vineyard 

Alternately, MyEfficient Vineyard open source website https://www.efficientvineyard.com/ 

 can be used.  MyEV is a collaboration between Cornell AgriTech viticulturist, Dr. Terry Bates, 
and Orbitist owner and software developer, Nick Gunner. Their teams look to integrate research 
based information in precision viticulture with essential data processing for a positive and 
productive end-user experience.       

Examples include assessing Frost Damage with NDVI in My EV.6 

Creating a digital representation of the vineyard is the foundation that provides an overview of a 
property for interrogation, allows for asset mapping/tracking and is the first step to digital 
twinning. Steps include progression from all of property contouring, identification of zones and 
then the ability to identify and track individual outliers.   

QGIS Map layering images of blocks, rows and individual vines 

 

 

 
6 https://www.efficientvineyard.com/blog/assessing-vineyard-frost-damage-with-ndvi-and-
myev?ss_source=sscampaigns&ss_campaign_id=6655e1cc3ddf5949567aecda&ss_email_id=6655ec3b
1ce7350c3089ec4b&ss_campaign_name=Frost+Damage%2C+Soil+Mapping%2C+and+more&ss_camp
aign_sent_date=2024-05-28T14%3A37%3A55Z 
 

https://www.efficientvineyard.com/
https://www.efficientvineyard.com/blog/assessing-vineyard-frost-damage-with-ndvi-and-myev?ss_source=sscampaigns&ss_campaign_id=6655e1cc3ddf5949567aecda&ss_email_id=6655ec3b1ce7350c3089ec4b&ss_campaign_name=Frost+Damage%2C+Soil+Mapping%2C+and+more&ss_campaign_sent_date=2024-05-28T14%3A37%3A55Z
https://www.efficientvineyard.com/blog/assessing-vineyard-frost-damage-with-ndvi-and-myev?ss_source=sscampaigns&ss_campaign_id=6655e1cc3ddf5949567aecda&ss_email_id=6655ec3b1ce7350c3089ec4b&ss_campaign_name=Frost+Damage%2C+Soil+Mapping%2C+and+more&ss_campaign_sent_date=2024-05-28T14%3A37%3A55Z
https://www.efficientvineyard.com/blog/assessing-vineyard-frost-damage-with-ndvi-and-myev?ss_source=sscampaigns&ss_campaign_id=6655e1cc3ddf5949567aecda&ss_email_id=6655ec3b1ce7350c3089ec4b&ss_campaign_name=Frost+Damage%2C+Soil+Mapping%2C+and+more&ss_campaign_sent_date=2024-05-28T14%3A37%3A55Z
https://www.efficientvineyard.com/blog/assessing-vineyard-frost-damage-with-ndvi-and-myev?ss_source=sscampaigns&ss_campaign_id=6655e1cc3ddf5949567aecda&ss_email_id=6655ec3b1ce7350c3089ec4b&ss_campaign_name=Frost+Damage%2C+Soil+Mapping%2C+and+more&ss_campaign_sent_date=2024-05-28T14%3A37%3A55Z
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Boundary and consistency of images in maps can be enhanced with contour tracking generated 
using ELVIS software and QGIS that provides x, y, z coordinates.  

Outputs can be used as communication tools, for example with contractors for spraying / vine 
training, graphical presentation of yield estimates for varieties or for marketing purposes.  

Drone imaging using RGB, LidAR and thermal cameras can also, for example, be used for 
identifying drainage lines, elevation and canopy temperature (see also UniSA research on sonic 
resonance for determination of inversion height).   The progression project will aim to convey 
components of this advanced level of drone mapping application, documenting and 
demonstrating this through workshop demonstrations / YouTube how to videos. 

For Quarry Hill, the wet winter and spring seasons in 2022 provided an additional benefit of 
dormant block mapping which was the identification of water run off on some blocks. This led to 
identification of specific locations within blocks to dig drainage trenches which were 
subsequently mapped using the RTK rover to map its position. This was overlayed into the QGIS 
maps for this vineyard. 

For Mount Nanima, frost and hail damage impacted vintage 2024. 

See the upcoming VSCD Vineyard vignettes 

• Frost events and options for measuring damage, quantifying yield loss and 
optimising positioning of frost fans, over-head frost sprinklers or IR tubes for 
maximum effect 

• Extreme weather events, considering cold air drainage and runoff maps 

Go to canberragrape.net.au 

  



‘Digital viticulture in the Canberra District’ 
 

14 
 

Case study 3: Side on imaging using RGB / NDVI sensors for 
bud, bunch, canopy, plant counts and health 

GoPro image capture / and NDVI imaging was demonstrated in Workshop 1 with the BitWise 
bud and bunch count software data collection using a GoPro mounted to an ATV and then the 
processing of data and results.  

The 'Budburst' workshop at Pankhurst Winery in Wallaroo, demonstrated the principle of rapid 
data collection using a GoPro and the Bitwise Greenview system. This allows for rapid data 
collection, computer vision processing and presentation of images generating as tabular data 
and results.   

A 'Flowering' workshop was held at Norton Road Wines, Wamboin included a demonstration of 
a hand held Greenseeker unit for point NDVI data collection and how data can be overlayed with 
comparative data within QGIS and the MyEV application. 

Side-on imaging for yield estimation 

Ground Based Survey of bud and bunch counts using BitWise Agronomy software  was 
evaluated. The BitWise Agronomy GoPro/Greenview technology utilises computer vision and 
machine learning AI to convert visual images into tabulated data. It also demonstrates the 
concept of “side on” sensing as opposed to “top down” undertaken using drones.  

BitWise provide links to online tutorials/documents on successful data collection to 
setup/position the GoPro camera, with key requirements being a wide view, setup of at least 30 
frames per second, data collection at no more than 8 – 10 kph and with sky as background.  

A GoPro camera is linked to a smartphone to control when the device is recording, with 
attention to detail on items such as making separate files for each row and noting direction of 
travel leading to high quality data capture.  

Bitwise can do bud counts pre-bud burst and bunch counts typically post–veraison. BitWise can 
also be used throughout the early growing season to track the rate of canopy development.   

They also offer a yield estimation aspect to their GreenView software.  

Alternatively, Cornell University in New York State has an ‘Efficient Vineyard’ project which is 
trialling side mounted sensors and broad utility in the platform.  
https://www.efficientvineyard.com/  

See the upcoming VSCD Vineyard vignettes  Bunch count yield estimates, finding an easier 
way to collecting representative data. Go to canberragrape.net.au 

 

 

 

 

 

 

https://www.efficientvineyard.com/
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Image of Bitwise Agronomy yield estimation software Dashboard 

 

Wine Australia’s Reading Between the Vines episode 7 features Rob Sutherland and Emma 
Taylor from De Bortoli Wines Yarra Valley vineyards who have been using Bitwise Agronomy’s 
Greenview system to support site management with its vine-based image technology and 
demonstrates: 7 

• Flexible use  

• Horizontal imaging and accuracy from side on imaging. 

• Ease of use with installation onto side by side vehicle / tractors and Go-pros. 

• Easy uploading and support with dashboards and analysis 

• Used for missing vines and quantifying replacements- Measuring impact of phylloxera 
and block yields 

The ‘Veraison’ workshop then demonstrated a mobile ATV mounted Greenseeker unit that 
generated NDVI relative to GPS data which was uploaded and presented in QGIS mapping 
software. A critical experience  was an understanding of how the Greenseeker sensor operated 
to ensure aspects such as correct speed of operation to deliver adequate density of readings 
and consideration of representative data collection that can provide meaningful outputs.  

The QGIS demonstration showed how having an established base – map to the level of 
individual vines can facilitate presentation of vine – level NDVI observations, snapping data to 
individual vines in QGIS using GPS location data. The analysis provided reporting of NDVI to the 
vine level while still being able to create a raster or contoured surface. 

 

 

 
7 https://www.wineaustralia.com/news/articles/reading-between-the-vines-episode-7 
 

https://www.wineaustralia.com/news/articles/reading-between-the-vines-episode-7
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Photo of Greenskeer hand held unit for NDVI plant logging 

 

 

See the upcoming VSCD Vineyard Vineyette - Canopy health and quantifying vineyard 
dieback through causes such as Eutypa lata, and monitoring grafting uptake and vine 
repair. Got to canberragrapes.net.au 
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Case study 4: Bringing it all together, storing and managing data  

The Collabraculture Wine Sector data model provides an example of how to structure data. This 
project created a logical schema; this being the basis for any vineyard database structure. The 
logical (or “common”) data model fits into the broader vineyard mapping landscape. 

Figure 1 (ensure image is referenced) 

 

  

 
  
Using this structure, a database can be created for the storage of vineyard mapping data, along 
with additional items or from Agtech devices data feeds.  

Monitoring site can include data on biosecurity, weather stations, frost, irrigation, variable rate 
applications, targeting sampling (ie. soil) etc. 

Storage in a database provides security and can facilitate data interoperability or exchange 
between devices, along with presentation of data in platforms such as Microsoft’s PowerBI. 

Transferring data between software is facilitated via a structured database. However, a vendor 
partner and the value proposition for managing multiple data sources also needs to be 
considered. Data engineering firms such as Pairtree and EarthSQL can deliver data integration, 
while also presenting data in ways that lead to deeper insights. 

The ability to store and manage data based on a common platform and set of data protocols is 
key to enabling vineyard monitoring, management and decision-making. As Loder (2024) 
observed ‘Here come the Robots, but what do we do with the data’?, the organisation of data is 
critical before insights can be deduced.8 

 
8 https://www.nuffield.com.au/post/here-come-the-robots-but-what-do-we-do-with-the-datath 
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EarthSQL provide a data management solution for viticulture, as outlined below. 

 

 

Earth SQL Scion database data - flow 

 

 

Key analytics that can be drawn from digital mapping and agtech to increase the value and 
relationship of data being collected can include: 

• Weather / temperature 
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• Rainfall  
• Soil moisture 
• Canopy temperature 
• Canopy growth – NDVI score per vine, row and block 
• Yield volumes per vine, row and bock 
• Rates of spray application and type for duration of growing season 
• Wind direction 

A definitive list of best practice analytics is to be developed post-project. 
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Case study 5: AgTech options for vineyard monitoring and management 

Digital mapping use case can guide the selection of AgTech options to address challenges.   

Challenges are then addressed through targeted, data collection (Agritech adoption!) with 
devices able to be positioned within the vineyard or blocks in an informed manner for 
representative data collection. 

This could be to address regional through to site–specific issues. Sensors and devices could 
include soil moisture probes, sensors that measure vine water status or likelihood of smoke 
taint9. AgTech innovation provides practical solutions to improve vine productivity and fruit 
quality. 

A final seminar and AgTech Event held on 25 October 2024 in Murrumbateman (sponsored by 
Department of Agriculture, Forestry and Fisheries) provided an opportunity for this project 
results and findings to be presented and discussed. The AgTech Event included a number of 
vendors who had worked on this project as well as new technology options that would integrate 
with vineyard mapping and monitoring to inform management.     

An Expert Panel at the event also discussed emerging technologies. They noted drones are 
affordable and accessible now compared to 5 or so years ago. In addition, drone maps and data 
can now use free platforms that are accessible – the challenge is what you do with the data and 
what you do with it. Dave Gerner from Wine Australia said “Anything that helps you make a 
decision is really valuable but you really want to know the decision you are trying to make it for”. 

Some of the technology options are listed below. 

Athena IR irrigation sensors 

Wine Australia’s Reading Between The Vines series showcases agtech technologies. Episode 
three features Hans Loder from Penley Estate in Coonawarra using Athena Irrigation’s system to 
gain a greater understanding of grapevine water needs.10 

Athena Irrigation is a plant sensor device labelled “transpIR” (transpiration by infra red) solution. 
This is a hardware sensor that sits above the canopy and feeds data to a cloud software 
solution, that interprets this data to provide insights into the status of how well vines are using 
water through a reading of vine water status.  

Soil survey and water sensors are complementary to the transpIR solution. The infra-red 
sensors measure canopy temperature, while the unit also collects data for relative humidity, 
solar irradiance and ambient temperature. Each can be viewed either as tabulated or in a 
graphical format, that is accessible over the web or phone. 

 

 

 
9 https://www.wineaustralia.com/news/articles/green-light-for-early-warning-smoke-detection-
system#:~:text=The%20network%20of%20100%20smoke,and%20accumulated%20seasonal%20smoke
%20exposure. 
 
10 https://www.wineaustralia.com/news/articles/reading-between-the-vines-episode-3 

https://www.wineaustralia.com/news/articles/green-light-for-early-warning-smoke-detection-system#:~:text=The%20network%20of%20100%20smoke,and%20accumulated%20seasonal%20smoke%20exposure
https://www.wineaustralia.com/news/articles/green-light-for-early-warning-smoke-detection-system#:~:text=The%20network%20of%20100%20smoke,and%20accumulated%20seasonal%20smoke%20exposure
https://www.wineaustralia.com/news/articles/green-light-for-early-warning-smoke-detection-system#:~:text=The%20network%20of%20100%20smoke,and%20accumulated%20seasonal%20smoke%20exposure
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Swan Systems variable water and nutrient management 

Links satellite imagery, water, soil moisture probes and temperature and canopy sensor 
information management to forecast irrigation planning. Creates consistency for growth and 
wine quality over variable seasons to adjust irrigation management.11 

https://sustainablewinegrowing.com.au/case-studies/using-technology-to-improve-water-
management-penley-estate/ 

https://www.wineaustralia.com/research_and_innovation/projects/plant-sensor-based-
precision-irrigation 

 

 

Carbon auditing 

Loder (2023) says farmers will one day use wearable technology to see data feeds, including AI-
generated management recommendations, on their land and in real time.12 

A number of vendors such as GetFarmLab are seeking to scale soil carbon baselining and 
decarbonize supply chains. Maps are all about the data base structure – standardised and in 
order – putting building blocks in place. Using data for land valuation – such as data that relates 
to soil is a near future need for accurate farm maps. 

 

 

 

  

 
11 https://www.wineaustralia.com/news/articles/reading-between-the-vines-episode-2 
12 https://www.nuffield.com.au/post/here-come-the-robots-but-what-do-we-do-with-the-data 

https://sustainablewinegrowing.com.au/case-studies/using-technology-to-improve-water-management-penley-estate/
https://sustainablewinegrowing.com.au/case-studies/using-technology-to-improve-water-management-penley-estate/
https://www.wineaustralia.com/research_and_innovation/projects/plant-sensor-based-precision-irrigation
https://www.wineaustralia.com/research_and_innovation/projects/plant-sensor-based-precision-irrigation
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Conclusion  

This project’s achievements against its objectives were as follows: 

- Advanced digital mapping has been undertaken and recording and documented as part of the 
project outcomes. This has been facilitated through workshops including Mammoth Geospatial 
using QGIS software and documented / video recorded to enable growers to replicate. 
Establishing a standardised Geopackage in QGIS as a next step that covers core viticulture 
features. Storage and database schema based on the Collabraculture model is also required to 
manage data. 

- The Group trial participants are now into their third vintage establishing digital maps that 
reflect the growing season at key phenological stages. Not all participants have had the same 
levels of experience or detail in their digital maps but understand that baseline maps provide a 
foundation that creates value and enables basic analysis and benefits straight away that can be 
built upon. 

- Bitwise technology was trialled for side on bud and bunch counts. Not all information 
gathered was successful when ground truthed and there were significant differentials on yield 
estimates. Inputing variables can assist in correcting this. However, Bitwise’s use of AI / 
Machine learning of images could be useful in other applications such as disease detection 
(crown gall in vine trunks) but would require training software and working with impacted sites 
to do so. 

- Alternately, the use of the Greenseeker NDVI data logger provided an easily useable and low 
cost option with only a small upfront cost for the unit. The data provided a GPS position and 
NDVI score that could be easily uploaded into QGIS. It's analysis can be overlayed against 
vineyard maps. it is a practical tool for logging missing vines or newly grafted vines, for example. 
It also shows potential as a way of collecting NDVI data in vineyards where flying drone missions 
is not possible i.e. in air space within 3 nautical miles of an airfield.  

- User guides have been developed for the above hardware / software and are (will be) available 
on the VSCD website canberragrapes.net.au 

The final group project seminar and industry AgTech Event (sponsored by Department of 
Agriculture, Forestry and Fisheries) provided an opportunity for the project results and findings 
to be presented and discussed. The AgTech Event included a number of vendors who had 
worked on this project as well as vendors demonstrating new technology options that can be 
integrated with vineyard mapping and monitoring to inform farm management.     

The VSCD Digital Viticulture project showed how digital maps create the foundation for the use 
of AgTech in its ability to solve problems and provide accurate, representative, reliable and 
accessible data over time. This provides an evidence base for important follow up projects that 
will contribute further to this objective and provide a model for wider adoption across Australia 
and potentially internationally in the viticulture and related agricultural sectors. Possible future 
projects could centre around the following proposed initiatives: 

• Access to a regional Scion platform with data being sourced from an agreed location 
• Production of a QGIS vineyard template which can be easily populated by growers 

when they capture a vineyard map; and 
• QGIS training provided by Mammoth Geospatial. 
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This project also demonstrated the efficacy of collaboration within a small grower group region, 
where sharing of expertise and future co-investment in equipment enables growers access to 
apply new technologies at small scale. The project also highlighted the benefits of undertaking 
some, but not all aspects of digital mapping, where outsourcing to vendors can be more 
efficient and cost effective at key points. 

As flagged at the start of this report, extension and uptake have moved to user trials to identify 
practical adoption. This project has had the opportunity for a small grower group to immerse 
itself with a range of new technology options, but more importantly, harness expertise along the 
way to support and provide advice across a wide range of scenarios – those problems that 
became immediate throughout the growing season – and identifying the key pieces of activity 
and information that create a foundation for future operational benefits. 

In summary, small grower collectives using shared resources require ongoing collaboration that 
is mutually advantageous and delivers benefits. This can be achieved through the following. 

• Establish an operating model for sharing resources (capital equipment and know-how) 
• Monetisng shared assets to create a sustainable co-investment foundation 
• Maximising uptake and best practice 
• Creating time horizons for agreed projects that address monitoring and management 

and problems solving for issues as they arise 
• Enabling innovation and trialling new technologies, such as increasing sustainability 
• And –  essentially, bringing this all together for consistency and quality in wine grape 

production in the target region as a point of difference. 

This is a potential model for small grower collaboration for technology adoption across 
Australia’s wine industry. 

Resources: 

https://www.dpi.nsw.gov.au/dpi/climate/farms-of-the-future/agtech-pilot-farm-blayney 

https://www.wineaustralia.com/growing-making/agtech-hub 

  

https://www.dpi.nsw.gov.au/dpi/climate/farms-of-the-future/agtech-pilot-farm-blayney
https://www.wineaustralia.com/growing-making/agtech-hub
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ATTACHMENT A - DRONE USER GUIDE  
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ATTACHMENT B - QGIS Notes 

 
Creating a Geopacakge to store the data derived from drone imagery 
 
Browser (top left) 
Navigate to project folder 
Right click – New – Geopackage – give it a name -> Quarry Hill Vineyard Data 
Layer-> Create Layer -> New Geopackage Layer 
Database –> select .gpkg created above 
Table name -> EndPost 
Geometry Type -> Point 
CRS -> GDA2020 Zone 55 
OK 
File Exists -> Add New Layer 
 
Creating End Post Points 
Select EndPost layer 
Click yellow pencil icon to make layer editable 
Click Add Point Feature 
Right click EndPost layer -> Select properties -> Select Attributes Form on left, change to Hide Form 
on Add Feature 
Click on end posts 
When finished, click yellow pencil icon to turn off editing and save changes 
 
Creating Rows 
Select Row layer 
Click yellow pencil icon to make layer editable 
Select Add Line Feature 
Enable Snapping (S or View->Toolbars->Snapping) 
Turn off attribute form as above 
Left click end post at each end of row, right click to finish row selection 
When finished, click yellow pencil icon to turn off editing and save changes 
 
May want to adjust layer properties to make colours stronger, thicker lines 
 
31:50 – Buffering rows to create block outline that can be traced 
 
Creating Blocks 
Select Row layer 
 
 
 
36:11 – Add attribute: Variety 
 
Using Statistics panel to calc no. rows, total row length etc. 
 
38:40 – Layer symbology – categorize by block name and classify 
 
39:21 – Add labels & area info 
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Buffering Rows 

Select rows to be buffered using  tool. 
Vector-> Geoprocessing Tools->Buffer… 
Check “Selected Features Only” 
Distance 0.5m 
Will create temporary layer. 
Double-click icon and add to existing Geopackage 
 
Clipping Imagery 
Raster->Extraction->Clip raster by mask layer 


